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Getting Started 

Introduction 
BioBrowser, the Modgen Biography Browser is a stand-alone software product which supplements the Modgen language 
used for dynamic longitudinal microsimulation modeling.  BioBrowser allows the analyst to graph the microdata 
generated by the model.  Its purpose is to aid in uncovering possible algorithmic errors in the model, or to study some 
particularly interesting cases with respect to the specified Modgen model. 

Microsimulation models written in the Modgen language generate synthetic lifetimes of individual actors.  Each actor is 
defined as a set of states which describe the characteristics of the actor.  For example, an actor could be a male individual 
whose attributes are described through the following states: age, sex, marital status, and health status.  The values of 
these states change as the actor progresses through his lifetime.  In our example, the individual’s age would change on 
each birthday while the marital status would change at the time point at which he/she was married, divorced, etc.   

BioBrowser is a tool which allows the analyst to graphically examine the characteristics and attributes of an actor over 
the course of his/her lifetime.  The BioBrowser can graphically present one or many states for one or many simulated 
lifetimes.  In this way, BioBrowser complements the other reporting features inherent in Modgen which are designed to 
provide detailed cross-sectional information on a collection of actors at a given reference time or state. 

The graphical representations produced by BioBrowser originate from a special database file which is the product of a 
Modgen model simulation run.  Once this file has been created there exists a variety of possible graphics which the 
analyst can create with BioBrowser.  The specifications of these graphics are controlled by the user through drop-down 
menus and options.  Therefore, an analyst with a limited knowledge of the Modgen modeling environment can create an 
impressive array of longitudinal graphics showing the characteristics of the actors at different points in time.  All of these 
graphical representations can be saved for editing at some future time and/or routed to a printer or clipboard. 

Specifying the contents of the database file requires the analyst to have some knowledge of the Modgen simulation 
environment.  A section below describes the components of Modgen with which one must be familiar to successfully 
create a database file.  Further details can be found in the Modgen Developer’s Guide. 

Contents of BioBrowser 
The Modgen Biography Browser (BioBrowser) installation package consists of a sample database file demo(trk).mdb 
and a sample biography file demo.bbr.  These files are referred to extensively to provide worked examples of the 
browser.  The nature of these files will be discussed in “How to Use BioBrowser: The Basics” on page 8. 
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System Requirements and User Feedback 
BioBrowser has been tested on Windows XP and does not have substantial requirements for CPU, disk or memory. 

Users with questions or problems with any aspect of this software are welcome to contact the development team at 
microsimulation@statcan.gc.ca. 
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Essential Components of a 
BioBrowser Session 

Modgen components 
Before using BioBrowser, it is important for the analyst to understand some of the essential components of Modgen. 

database (.mdb) files 

These files are created by Modgen during the simulation phase of the model.  They contain the raw data necessary to 
construct the graphical representation created by BioBrowser.  Although the database files can be read by BioBrowser, 
BioBrowser can never modify the contents of these files.  All BioBrowser sessions begin by opening a pre-existing 
database file. 

dominant actors 

These elements are at the core of any Modgen simulation exercise.  Dominant actors are usually persons or households 
which are created at the beginning of the simulation process and undergo changes to their characteristics as they proceed 
through their lives.  Dominant actors are defined by their characteristics (states) and by the events which transform their 
states. 

non-dominant actors 

Modgen simulates one case at a time where a set of dominant actors undergoes changes to its states.  One possible 
change to a person actor’s state is a marriage or a common-law union.  When this event has occurred, Modgen generates 
an appropriate spouse.  This spouse, another person actor, is termed a non-dominant person actor.  Once created, non-
dominant actors undergo the same possible events as the dominant actors of the same type.  Non-dominant actors are 
linked to their dominant actor. 

tentative actors 

The process of generating a non-dominant actor in Modgen involves generating a sequence of potential candidates.  The 
candidates who are not chosen are termed tentative actors since they have no links to any of the dominant actors in the 
model. 

states 

These elements define the characteristics of the actors over the span of their lifetimes.  Examples of states might include 
age, employment status, or educational attainment.  States can be scalars or arrays.  

 

Before beginning to use BioBrowser, a database file needs to be created using Modgen. If you want to examine states 
which are not in the database, a new Modgen simulation must be run and a new database file needs to be created.  A 
sample database demo(trk).mdb was included with this software package.  For more information on creating new 
databases in Modgen please refer to the Modgen Developer's Guide or, for a quick overview/refresher, see “Appendix: 
Creating a New Modgen Database File” on page 22. 
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BioBrowser components 
BioBrowser takes the database and creates graphics of the characteristics of the actors.  In addition to the above Modgen 
concepts, there are other concepts which relate specifically to BioBrowser. 

biography (.bbr) files 

These files contain the graphical representations which the analyst has created during a BioBrowser session.  The 
biography files can be created, saved, and edited by the analyst during a BioBrowser session. 

display band 

The graphical display of a state or linked actor. 

filter 

The criteria used to narrow or refine the set of actors to be used in a biography.. 

navigation band 

A type of display band which also includes a set of buttons which allows the user to go from the display bands of one 
actor to another and add new states to the biography.  The buttons resemble the control buttons on the front of a CD 
player. 
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The BioBrowser Menu and 
Toolbar 

Menu Commands 
The BioBrowser menu bar contains a set of standard menus available in most Microsoft Office applications, as well as 
some application specific commands.  Some of the same functions may be available as Toolbar buttons or through 
keyboard equivalents.  

 

 

Pop-up menus:  Some commands are only available from pop-up menus or by double-clicking on the chart area over the 
display bands of the desired state.  Use the right mouse button click to access the pop-up menus. These menus will differ 
depending on whether or not the state is a simple state or a linked actor. For simple states such as “employed” below, the 
following commands are available: 
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For the filter tracking band and linked actors, access is also provided to the navigation band commands, as shown below. 
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The Toolbar 
The toolbar provides quick access to the most frequently used menu items and commands in the BioBrowser application. 
Each button is described by a Tool-Tip or status bar description. If you have a small screen at low resolution you may 
choose not to display the Toolbar. Choose Tools/Options and Click on the View Toolbar Option. 

 

Icon Description Menu Equivalent 

 
Create New Biography   File/New 

 
Open Saved Biography   File/Open 

 
Save Biography File/Save 

 
Print active biography File/Print 

 
Copy active biography to clipboard Edit/Copy 

 
Undo Last Add Edit/Undo Last Add 

 
Show or hide grid lines Format/Grid Lines 

 
Show or hide guide lines  Format/Guide Lines 

 
Show or hide navigation bands Format/Navigation Bands 

 
Change background colour Format/BackGround Colour 

 
Change chart colour Format/Chart Colour 

 
Invoke BioBrowser Help Help/Contents 
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How to Use BioBrowser: The 
Basics 

This section introduces the basics of using BioBrowser. 

Beginning a BioBrowser Session 
To begin a BioBrowser session, click the Start button on your toolbar, choose Programs, and then select BioBrowser. 

Opening an Existing Database File: The File/Open 
Database Command 
BioBrowser automatically invokes this command at the start of every session. A database file (created by Modgen) must 
be open before any graphical representations (saved as a biography) can be created.  Although only one database file can 
be open at a time, any number of biographies can be viewed simultaneously. 

A sample database demo(trk).mdb has been supplied as part of the BioBrowser installation. 
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Opening a Saved Biography: The File/Open Command 
After you have opened the database upon the startup of BioBrowser, you will be asked to either create a new biography 
or open a saved biography.  One saved biography demo.bbr has been supplied with the installation software.  Choose 
the Open button. 

 

You will be prompted for the name of the saved file to open. Choose demo.bbr. 

 

Creating a New Biography: The File/New Biography 
Command 
Creating a new biography involves the selection of the actors which you want to graph by choosing a starting actor and a 
filter.  The way in which the open database was defined in the Modgen model will limit the available choices.  The 
Starting actor is the type of actor whose state characteristics will be graphed.  Other actors who are linked to these 
starting actors (e.g. parents, spouses or children) may be added later in the BioBrowser process.  In our example, two 
starting actors are available: (i) persons, whose states are included in the database only if they are dominant actors or 
other married or remarried individuals, and (ii) children. 
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This choice of starting actor may give a large set of actors to be graphed, depending on the size of the Modgen database.  
The filter criteria enables you to narrow the focus of the biography. Select a state, an operator on that state, and a value.  
This generates a SQL query on the database.  The result of the query is a set of actors which satisfy the filter criteria.  At 
present, two states can be used to determine the filter.  When selecting two states, you must choose if the criteria will be 
joined with an “And” or an “Or” condition. If the result of the query is non-empty, then a new biography is opened. Once 
the biography is open, you may change the criteria using menu item Filter/Criteria …, as discussed in “Changing the 
Biography Filter” on page 16. 

The tracking state is a variable which indicates the ranges of time in which the actors and their states are included in the 
database.  If you wish to browse all the starting actors, set the filter to Tracking = TRUE in the Filter Criteria section of 
the Biography Filter dialog box..   

In the “Filter Description” box you may change the textual description of the filter you have chosen.  It will appear on 
the bottom of the BioBrowser screen. 

In the example below, all person actors whose dominant state is True were selected for browsing. This is a logical state 
whose value is either True or False for the actor’s lifetime. Since the demo(trk).mdb file was created with only 20 
cases, all 20 actors will meet this criteria. 

 

The new biography contains only one display band, the navigation band for the filter tracking state.  It indicates the dates 
in which the actor’s state characteristics were captured by the model (the axis at the bottom of the screen indicates the 
start and end dates).  The display band does not have to be continuous.  On the top of this display band the number of 
actors which satisfied the filter criteria is displayed as well as which actor is presently being shown on the screen.  In the 
example below, the first actor out of the twenty which were filtered is being displayed. A later section, “State Selection 
and Navigation” on page 12, will explain how more states can be added to the biography. 
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Saving a Biography: The File/Save and File/Save As… 
Commands 
Once all desired states have been added (formatted for style and colour), you may optionally save the biography to file. 
These files have extension .bbr and may be retrieved at a later time against a compatible data base.  For compatibility, 
the filter query must be non-empty and all previously selected actor/state pairs must exist in the open database. All style, 
colour and navigation positions are saved.  

 

If you have altered the state data within a biography, the window caption will display an asterisk (*) after the file name 
until you save the biography.  This visual asterisk cue is not set, however, by navigation or by changes to global 
biography options. 
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State Selection and Navigation 

State Selection 
Once a biography is created, you may modify and enhance it by adding display bands for different states.  You may add 
display bands of the states for the filtered-in actors (e.g. their earnings).  You may also add display bands for linked 
actors (e.g. their spouses) as well as for the states of these linked actors (e.g. the educational status of the spouses). 

The following set of buttons is used for state selection and navigation: 

 

    

 

In order: Add , First , Previous, Next and Last 

Add more states by using the Add  button shown above and displayed to the right of the chart area.  States added using 
the button are always added to the bottom of the chart area.  However, for more functionality, use the pop-up menus over 
the chart area. These menus allow both insertion and deletion of states anywhere on the screen. Insertion will insert the 
state after the clicked position. Deletion will delete the state at the clicked position without notification unless an actor 
band is deleted with dependent states below it. In this case, BioBrowser will issue a warning indicating how many states 
will be deleted and provide an option to ignore the delete. The filter tracking band cannot be deleted.  

You may add any number of states, any number of times, subject to the limitations of your monitor. The states can be 
added in any order subject to maintaining the visual hierarchy of the link bands. In this case, the Add button for that band 
will be disabled.  The arrows indicate the indentation in the hierarchy. 

Edit/Undo Last Add can be used to repeatedly delete any number of states from the bottom up.  To automate navigation 
of the filtered-in actors (the topmost display band), use the Timer  command from the Tools Menu, which will navigate 
through each actor automatically. To go to a specific object in the filter band, use the GoTo command in the Browse 
Menu.  All state selections and the current positions of navigation bands are saved with File/Save. 

Here is an example of the Add/insert states dialog box for the demo file supplied with this application.  In this case, the 
Add button from the top navigation band was clicked, showing the states for the person actor.  Use extended selection to 
select/unselect more than one state i.e. Ctrl-Click to select/unselect states, Shift-Click to select a range of states. Press the 
OK button when your selection is complete. 
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Note above, that the description of the tracking state contains the tracking condition for this actor used at database 
creation time. In this case, non-dominant persons (spouses) are tracked only when their marital status is married or 
remarried.   

State Navigation 
Navigate by using the First , Previous, Next, and Last buttons shown above or by using a pop-up menu over a 
navigation band. The pop-up menu has the additional functionality of a “Go To” command. 

The first navigation band always refers to the filter query.  If you add a linked actor, a new navigation band is created by 
BioBrowser.  This band differs from the topmost band in several ways. First, unlike the topmost display band which 
shows the tracking state for the filtered-in actors, those for the linked actors graphically display the time frame in which 
the related actors are linked to the filtered-in actors (as opposed to when the related actors were tracked by Modgen).  If 
you wish to see the tracking state, then you may add it as a separate display band. 

Secondly, for linked actors, you are permitted to navigate beyond the total count for the current set of actors within the 
band.  This is useful when adding the same link more than once.  For example, a person actor may be linked to multiple 
child actors.  This actor may have 0 to 6 children. If you wish to see certain states for the first 2 children within the same 
biography window, add the link to child state twice and position the navigation bands at 1 and 2 respectively. These 
positions are retained as you navigate from person to person.  If the current person-actor has no children, this navigation 
will still work although the bands will show (1/0) and (2/0) and no states will be displayed.  In this case, the First  button 
will go to 1/0, the Last button will have no effect on the position. 

With small screen resolutions, you may choose to hide the navigation bands and use the pop-up menus for movement. 
This is illustrated below. 
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Alternate keyboard navigation is available for the top filter band.  The Filter/Browse menu contains a Go To and the 
four movements with optional Ctrl key equivalents: Ctrl+G  for GoTo, Ctrl+Q  for First, Ctrl+W  for Previous, Ctrl+E  
for Next and Ctrl+R  for Last. 
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Browsing and Changing the 
Underlying Chart Data 

Browsing the Data Longitudinally 
To browse the actual data underlying a specific state in the chart, use the Show Longitudinal Data  command in the 
state pop-up menu.  This command will open a window showing exact times and values used to plot the data. It typically 
contains values of two states, the tracking state and the actual state selected. The highlighted cell in the Time column of 
the grid will be the closest time of lesser or equal value to the X axis position of the mouse when the window was 
opened.  

 

Copy any selected block of this data to the clipboard using Edit/Copy  or Ctrl+C . To select an entire column, click its 
header tile. To select all data within the window, click and drag across all header tiles. 

The Show Longitudinal Data window contains a subset of records from the History  table of the database file.  
Advanced users may wish to use the object identifier shown in the caption (optionally with the state identifier, also  
shown there) to open the database file directly with MS Access and perform further analysis in that environment. 
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Browsing the Data Cross Sectionally 
To browse the chart data for all states at a specific point in time, use the Show Cross Sectional Data command in the 
state pop-up menu.  This command will open a window showing state values for all selected states at the point in time on 
the X axis where the mouse was clicked. 

 

Changing the Biography Filter 
Once the biography is open, use menu item Filter/Criteria to change both the biography filter and its description. If the 
filter is changed and the resulting query is not empty, the biography filter tracking band is reset to position 1.  Use menu 
item Filter/Description…  to change only the filter description without affecting the position of the filter tracking band. 

You may choose either 1 or 2 conditions for the criteria, both containing a state, operator and value combination. In the 
case of one condition, select the ‘No second criteria’ option within the Filter Criteria frame.  In the case of two 
conditions, choose either the ‘And with first criteria’ option or the ‘Or with first criteria’ option. The And criteria will be 
met if both conditions are satisfied at any time in the actor’s lifetime. Note very well that the conditions do not have to 
be met simultaneously (over the same period of time). The Or criteria will be met if either condition is satisfied at any 
time in the actor’s lifetime. 
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The above filter demonstrates the use of an And  condition. In this case, the person actor must be dominant (a state which 
is either True or False at birth and never changes) and earnings must have exceeded $100,000 at any time in that 
person’s lifetime. 
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Display and Output Options 

Formatting the Chart Area 
When a state is added various defaults for chart presentation are used depending on its Modgen state type.  At present, 
five chart types are permitted: 

 

Line Level Horizontal Bar Point 

   
 

 

Event 

 
 

BioBrowser recognizes the following Modgen state types and plots them by default according to their state type: 

State Type Default Chart Type 

Integer Level 

Long Level 

Floating Point Line 

Double Line 

Time Line 

Logical Horizontal Bar 

Classification Event 

Range Level 

 

The Line style draws one line between 2 adjacent points, whereas the Level style draws two lines (a vertical then a 
horizontal) between 2 points.  The Horizontal Bar, although most appropriate for logical, classification and range type 
of Modgen states can be used on all states.  For continuous states such as float or double, the horizontal bar uses colour 
interpolation from a start and end colour defined by the user.  No legend is available for Horizontal Bar .  
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The default colour for Line, Level and Point plots is blue.  The default colours for Horizontal Bar  are white and gray.  
You can control the line thickness, band width and point size for the biography but not at the level of a single state.  At 
present, these settings are global to the biography window.  All such settings are saved with the biography. 

Double-click on a chart within a biography, or right click on it and select State Properties from the pop-up menu, to re-
format it for chart type and colour.  A format string for the Y-Axis labels where appropriate can be changed at this time 
as well.  The following dialog box is used to set or adjust these properties: 

 

If the chart type selected is Horizontal Bar  a second colour will be presented for selection. For logical states, these will 
be the False and True colours. For all other states types these will be used as a start colour and end colour in a colour 
interpolation process. 

Setting and Saving Display Options 
Use the Format menu commands to change display options for the active biography window. The View menu, which 
includes the ToolBar and Status Bar display options, are application global.  

The Tools/Options menu can be used to set and save session defaults and display default options for new biographies. 
The Options dialog box consists of three tabs: General, Chart Defaults and Axes Defaults. The General options will take 
effect immediately, whereas the two Default tabs are used only with new biography creation. The OK button will save 
these defaults to your application ini file. 

The General tab below sets and saves session defaults used at application startup. To change them during the session, use 
the View and Tools menus. 
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The chart defaults used for new biography creation consists of the following display options. To change these options for 
an already open biography, use the Format menu. 

 

Axes defaults for new biography creation are set and saved within the third options tab. Axes properties for an open 
biography can be set by double clicking the axes area of the chart window or by using the Axes Properties  command 
from the Format menu.  
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Note that all display options and axes properties currently in effect for the open biography are saved with the biography 
file.  

Sending a Biography to the Printer or Clipboard 
To print a biography, use File/Print  or the Print button on the toolbar. 

The printed biographies are sized to fit the page while maintaining their aspect ratio. The orientation used will depend on 
the aspect ratio of the biography window being printed, i.e., if the window is wider than tall, landscape will be used. 

To send a biography to the clipboard, use Edit/Copy, Ctrl-C or the Toolbar copy button.  
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Appendix: Creating a New 
Modgen Database File 

Overview 
If you want to make a biography using different actors and/or states, you will need to create a new database using 
Modgen.  The creation of the database file occurs with the execution of a Modgen simulation model and, therefore, 
requires some knowledge of the Modgen simulation environment.  The name, location, and contents of this special file 
are controlled as follows: 

• the filename, its location within the directory structure, and the number of simulated lifetimes contained within 
the database file are defined through a Modgen scenario and its Scenario Settings dialog box.  Modgen manages 
model run outputs by using the scenario name followed by a bracketed identifier indicating the type of Modgen 
output and an extension indicating the type of file. For tracking outputs, the convention used is: 
scenario_name(trk).mdb. 

• the set of actor/states to be displayed by BioBrowser must first be listed in the model variable tracking facility 
within the Modgen source code for the specific simulation model. This set including the tracking filter for each 
actor are required by the model at compile time and can not be dynamically set at run time. 

Scenario Settings 
There are a variety of Modgen scenario settings which determine the nature of each specific simulation.  The scenario 
settings are discussed in complete detail in the Modgen User’s Guide.  However, there are three main settings which 
must be understood in order to create an appropriate database file for the Biographical Browser. 

• In the Scenario/Settings/General tab, select "MS Access tracking". This setting tells Modgen that, in addition 
to the other outputs specified, a tracking database file is requested as output for this model run.   

• For case based models, select the number of cases in the Scenario/Settings/General tab. As a general rule, it is 
important to specify a small number here since all of the simulated cases which meet the tracking filter will be 
included in the database file. The size of this file can become very large, very quickly depending on the number 
of cases and states included. In addition, variable tracking will slow the simulation down considerably. 

• For time based models, select the time-units in the Scenario/Settings/General tab.  

The demonstration file accompanying this release, demo(trk).mdb, contains 20 cases (which for this model corresponds 
to 20 simulated lifetimes of a person actor whose dominant state is True). It was created from the Statistics Canada 
model, LifePaths. 

Modgen Model State Tracking 
The tracking facility provided by the Modgen language controls the type of actors to be included in the database file 
along with the list of states which are to be analyzed with BioBrowser. 
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The track command must be included in one of the .mpp files which contain the Modgen model code which define the 
simulation model.  If the analyst wishes to change the type of actors to be tracked, or change the complement of the 
states to be output, then the Model must be re-compiled.  This is discussed further in the Modgen Developer’s Guide.  
This guide should also be consulted by readers who are unfamiliar with the concepts outlined in the syntax and examples 
which follow.  

Syntax of the Track Command 

 track actor_name [filter] { state_or_link , ... , state_or_link } ; 

It is important to remember that only one track definition is allowed for each actor in the model.  In addition, the filter 
specifies if and when an actor’s states or links are to be output to the database file.  

Example 

In this example, the states which describe the person are only output to the database file when he/she is married or 
remarried (the dominant characteristic is discussed in the Modgen Developer’s Guide).  Therefore, if the person was 
married at age 25, divorced at age 40, and re-married at age 50, then the database file would only contain information on 
this person from the ages of 25 through 40; and 50 to the age at death.  There are nine states which describe the 
characteristics of the individuals stored in the database file.  The last two items of the track definition are not variables 
but links to other individuals associated with this person.  In this case, the database will contain information on the nine 
variables defined in the track command on the person’s spouse and children if they are present. 
 

track Person 
[ dominant || mar_status == MARRIED || mar_status == REMARRIED ] 
{ 
 es_state, 
 ed_level_ep, 
 sex, 
 dominant, 
 employed, 
 mar_status, 
 marstat_legal, 
 fte_earnings, 
 children_at_home, 
 lSpouse, 
 mlChildren 
}; 
 

Example 

In this example the date of birth and sex states for a child actor are output to the database file once the child is 
established in a family (the tentative characteristic is discussed in the Modgen Developer’s Guide. 

track Child [ !tentative ] 
{ 
 date_of_birth, 
 sex, 
 mlParents 
}; 
 

Contents of the Database File 
The MS Access file produced by a Modgen simulation contains a data table called History  and the following dictionaries 
organized hierarchically: 
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ActorDic - actor dictionary. 
ActorStateDic - tracked state dictionary. 
ActorLinkDic – tracked linked actor dictionary. 
TypeDic - state type dictionary containing a pointer to a specific dictionary below. 

The dictionaries for each state type are as follows: 

SimpleTypeDic - for simple state types e.g. integer, double, float. 
LogicalDic - for logical states. 
ClassificationDic and ClassificationValueDic - for classification states and their values. 
RangeDic - for range type states. 
TypeDic - for linked actors. 

Any dictionary with textual identifiers will contain 1 record for each language implemented in the specific Modgen 
model, as indicated by LanguageDic.  

In addition, a file version table called VersionInfo will indicate the version of the tracking file. The BioBrowser uses this 
version to maintain backward compatibility if the tracking database design is changed. 

The History  table contains one record for each tracked state at one point in time. A record is added to this table, each 
time a tracked state changes for each tracked actor. The History table fields used by BioBrowser are: an object identifier, 
time, a state identifier, and a value for the given state.  The ShowData window contains a subset of records from this 
table. Since the object identifier is common across all records in the ShowData window, its value is shown in the window 
caption.  
 
 


